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1. About Kernel Office365 Migrator for GroupWise 

1.1 Brief about this User Manual 

Welcome to the user manual of Kernel Office365 Migrator for GroupWise, an apt solution to migrate single 
as well as multiple GroupWise User Mailboxes to Office365. This user manual guides users on 
successfully operating the software. It is recommended that novice as well as experienced users should 
carefully go through this user manual before using the software. A user who is well aware of the software 
can even use table of contents for finding the particular portion of manual. The table of contents enlists all 
the sections described in this user manual from where one can navigate through its different sections. The 
user manual consists of step-by-step guidelines for using Kernel Office365 Migrator for GroupWise 
software. The user manual is intended to guide those users who are using this software for the first time. 
The user manual consists of the following sections for guiding the users: 

 Introduction 

 User Interface Description 

 Install and Uninstall 

 Usage Guidelines  

 Download, Purchase and Register 

 Troubleshooting 

 Legal Notices 

 

1.2 Introduction to Kernel Office365 Migrator for GroupWise 

Kernel Office365 Migrator for GroupWise is an advanced, effective, professional and result-oriented 
software that helps users in migrating from Novell GroupWise Server environment to Office365 
environment with complete accuracy. The software offers reliable, accurate and secure migration from 
Novell GroupWise to Office365 and migrates user mailboxes, calendar entries, tasks, and personal 
address books from Novell GroupWise mailboxes and stores them in new user mailboxes on Office365. 
The software is very much helpful for organizations, companies, administrators, technicians  who want to 
switch from Novell GroupWise Server to Office365. 

Kernel Office365 Migrator for GroupWise is an Email migration software that migrates all the items 
including Emails, attachments, calendar entries, contacts, folders, trash items, sent items, documents, 
checklist, work in progress, cabinet, Unicode characters, journals, notes, archives and all existing personal 
folders in GroupWise mailboxes to Office365 with complete accuracy. The software offers options for single 
as well as multiple GroupWise mailbox migration. 

Single GroupWise mailbox migration option allows migrating only a single GroupWise user mailbox at a 
time and offers three modes – Default Mode, Login Mode and Command Line Mode for connecting to the 
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Novell GroupWise. Unlimited GroupWise mailboxes  migration option allows creating a .NUCON batch file 
or an .XLS Excel sheet of GroupWise mailboxes consisting of complete details of user mailboxes to be 
migrated and thus saves administrators’ time of migrating user mailboxes one-by-one. 

The software offers easy-to-use, highly interactive, self-descriptive, user-friendly graphical user interface 
such that non-technical users can easily operate it without any technical training. 

Kernel Office365 Migrator for GroupWise is available as a free trial version such that users can evaluate 
the features, functionalities and capabilities of the software before making the actual purchase. The free 
trial version works almost similar to that of the full version of the software but has a limitation that it allows 
saving only first 10 items per folder from the user mailbox. In order to save all the migrated email items of 
the user mailboxes, purchase the licensed version of the software. 

Kernel Office365 Migrator for GroupWise supports every version of Novell GroupWise Server and MS 
Excel for performing the migration process. 

 

1.3 Salient Features 

Some of the key features of Kernel Office365 Migrator for GroupWise software are: 

 Accurately migrates each and every item of GroupWise user mailboxes to Office365 including 
Mailbox, Sent Items, Calendars, Contacts, Documents, Checklist, Work in Progress, Archives, 
Cabinet and Trash Items. 

 Migrates single as well as multiple user mailboxes from Novell GroupWise to Office365. 

 Migrates batch of Novell GroupWise mailboxes to Office365 with the help of .NUCON batch file or 
.XLS worksheet consisting of complete details of user mailboxes to be migrated. 

 Supports migration of mailbox folders whose names consist of Unicode characters. 

 Migrates archived GroupWise mailbox items, complete Address books as well. 

 Migration of batch GroupWise mailboxes to Office365 using .NUCON or .XLS file saves much 
valuable time of administrators. 

 Recovers and migrates even deleted items. The tool recovers emails in Trash folder and then 
migrates and saves them in Office365. 

 Supports accurate Unicode character migration. 

 Displays preview of migrated email items in a tree-like structure before saving. 

 Available as free evaluation version to let users analyze the features and capabilities of the 
software for free before making an actual purchase. 

 Supports every version of Novell GroupWise Server and MS Excel for performing the migration 
process. 
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 Offers an easy-to-use, self-descriptive, user-friendly Graphical User Interface. No technical skills 
required for operating the software. 

 Offers round-the-clock technical support. 

 

1.4 System Requirements 

Your computer system must have the appropriate configuration before installing and running Kernel 
Office365 Migrator for GroupWise software. Following are the minimum system requirements that a system 
should possess for successfully installing the Kernel Office365 Migrator for GroupWise software. 

 

Basic System Requirements 

 Pentium Class Processor 

 Minimum 64 MB RAM (128 MB Recommended) 

 10 MB of free Disk Space for Software Installation 

 Enough disk space to store the recovered results 

 

Supported Operating Systems Platforms 

Windows Server 2000, Windows Server 2003, Windows XP, Windows Vista, Windows Server 2008, 
Windows Server 2008 R2, Windows 7, Windows 8. 

 

Supported Novell GroupWise Server 

Version 6, 6.5, 7, 8 and 12 

 

Supported MS Excel Versions 

MS Excel 97, 98, 2000, 2002, 2003, 2007, and 2010. 

 

 Note: The Novell GroupWise Client and the .DB file, that is, User Mailbox file should be of same 
version or higher version. If both the versions do not match or either of them are not of the same or 

higher version, then chances are that Kernel software might give some error messages. 
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 Note: MS Excel and Novell GroupWise client should be installed on the computer system on which 

you are performing the migration otherwise migration of user mailboxes is not possible. 

  

 Note: Internet connection should be available and Microsoft .NET Framework 4 must be installed 

on the host computer. 
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2. Understanding the User Interface 

2.1 Welcome Screen of the Software 

Kernel Office365 Migrator for GroupWise offers user-friendly, attractive graphical user interface. When the 
software is launched, following Welcome Screen appears: 

 

 

Figure 2.1: Welcome Screen of Kernel Office365 Migrator for GroupWise 

 

2.2 Menu Bar 

      The Menu bar of Kernel Office365 Migrator for GroupWise software comprises of three menu items that are 
further divided into several sub-menu items. The three menu items are: 

 File Menu 

 Tool Menu 

 Help Menu 
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File Menu 

The File menu of Kernel Office365 Migrator for GroupWise appears, as shown in the following figure: 

 

Figure 2.2: File Menu 

The following table enlists the options available in the File menu: 

 

 

 

 

 

Tool Menu 

The Tool menu of Kernel Office365 Migrator for GroupWise appears, as shown in the following figure: 

 

Figure 2.3: Tool Menu 

Advance Options: Select this option to view advanced options in order to customize various activities. 

Option Description 

Single Mailbox Migrates Single GroupWise User Mailbox 

Batch File Migrates Multiple GroupWise User Mailboxes saved in a batch file 

Export Exports/saves items of User Mailbox 

Exit Select this option to exit from the software 
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Figure 2.4: Setting Advanced Options 

Enable or disable the appropriate checkbox field: 

 GroupWise login options for batch file: Check this option to provide the value for number of 
times the software will try to establish the connection with the Novell GroupWise and the time 
elapsed (in seconds) between retries. 

 Export into existing folders in Office365: Select this checkbox, if you want to save the migrated 

items from Mailbox folder of GroupWise mailbox to Office365. 
 Advance settings for Sent Items: Select this checkbox to activate advance settings for Sent Items 

migration. If in case, the Sent Items folder emails are listed and migrated slowly, then select this 
option to make it fast. 

 Do not save Calendar items in Calendar view: Select this checkbox to save the migrated 

calendar items in list form view in Office365 instead of the default calendar view. 
 Change the name of GroupWise folders while migrating into Office365: This option will allow 

you to change the folder names of GroupWise mailbox while migrating to Office365. Select this 
checkbox to activate the section where Default GroupWise Folders name, GroupWise folders and 
Office365 Folders are listed. From here you can easily modify the folder names of GroupWise 
mailbox and Office365 mailboxes for migration. Supports Unicode language folder migration. 

 

Help Menu 

The Help menu of Kernel Office365 Migrator for GroupWise appears, as shown in the following figure: 
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Figure 2.5: Help Menu 

The following table enlists the options available in the Help menu: 

Option Description 

Help Opens the user’s help manual of Kernel Office365 Migrator for GroupWise 

Software home page… Opens homepage of the software on the Website 

About Kernel Office365 
Migrator for GroupWise 

Displays the version information and support details of the software 

 

2.3 Tool Bar 

The Tool bar is displayed just below the Menu bar section of the software interface and consists of buttons 
that offers a convenient method for performing varied functions. 

 

Figure 2.6: Tool Bar 

Following table enlists the buttons available on the Tool bar of Kernel Office365 Migrator for GroupWise:  

Button Button Name Description 

 

Single 
Mailbox 

Click this button to migrate Single GroupWise User Mailbox 

 

Batch File Click this button to migrate Multiple GroupWise User Mailboxes saved in a 
Batch File 

 

Export Click this button to Export/Save items of the User Mailbox 

 

Help Launches User’s Help Manual of the software 

  



© L e p i d e  S o f t w a r e  P r i v a t e  L i m i t e d               

3. Install and Uninstall 

3.1 Installing Kernel Office365 Migrator For GroupWise 

After being familiar with the software overview, key features, and system requirements let us install Kernel 
Office365 Migrator for GroupWise. The software is easy to install and involves few simple steps to 
configure it. However, before installing the software ensure that the software installer file is available on 
your computer and the host computer meets the entire system requirements. Also, the computer system 
must have sufficient memory available. If the installer file is not available on your computer, then you can 

download it from our safe and secure Website: 

http://www.nucleustechnologies.com/download-groupwise-to-office365.html 

 
After you have downloaded the installer file, execute the following steps to install the software: 

1. Double-click the Kernel Office365 Migrator for GroupWise installer file. 

2. Accept License Agreement to continue the installation of the software. 

3. Follow all the on-screen instructions. The setup install completion screen will be displayed. 

4. Click the Finish button to successfully install the software. The main window of the software will be 

launched. 

 Note: When you run the Kernel software setup, two programs gets installed in the All Programs 
menu and two desktop icons are created: Kernel Office365 Migrator for GroupWise.exe  

and Kernel Office365 Migrator for GroupWise – Batch File Creator.exe.  

Kernel Office365 Migrator for GroupWise Batch File Creator software will automatically install as you 
install the Kernel Office365 Migrator for GroupWise software. 

 Note: It is necessary to have Full Administrative Rights on the computer system(s) where you are 

performing the migration process. 

 

3.2 Uninstalling Kernel Office365 Migrator for GroupWise 

Kernel Office365 Migrator for GroupWise software can be uninstalled from the computer system in two 
ways: 

 From the Windows Start Menu 

 From the Control Panel 

 

Uninstall from the Windows Start Menu: 

 

1. Click the Start button from the Windows menu. 
2. Click All Programs > Kernel Office365 Migrator for GroupWise  > Uninstall Kernel Office365 

Migrator for GroupWise. 

http://www.nucleustechnologies.com/download-groupwise-to-office365.html
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3. A warning message before uninstalling the software appears on the screen. Click Yes button to 

uninstall the software. 

Kernel Office365 Migrator for GroupWise is successfully uninstalled from the computer system. 

 

Uninstall from the Control Panel: 

 

1. Click the Start Menu > Control Panel and then double-click the Add or Remove Programs icon. 

2. Select Kernel Office365 Migrator for GroupWise and then click Remove button. 

3. A warning message before uninstalling the software appears on the screen. Click Yes button to 

uninstall the software. 

Kernel Office365 Migrator for GroupWise is successfully uninstalled from the computer system. 
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4. Getting Started with the Software 

4.1 Migrate Single GroupWise Mailbox 

Follow the steps given below in order to perform the migration of single GroupWise user mailbox to 

Office365: 

1. Launch Kernel Office365 Migrator for GroupWise software. Select the migration option – “Select 

this option to migrate single GroupWise Mailbox” and then click Next button. 

 

Figure 4.1: Single GroupWise Mailbox migration Selection 

 

2. On clicking the Next button, following window appears: 
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Figure 4.2: Modes to connect to GroupWise Mailboxes 

 

The window displays three modes to connect to the user mailboxes of Novell GroupWise and archive 

selection option. Choose any of the mode in order to perform the migration of single GroupWise mailbox. 

 Default Mode: This mode helps to migrate the default opened user mailbox in Novell GroupWise 

Server. 

 Login Mode: This mode provides sub-modes where mailboxes can be migrated with Online details, 

Caching Mailbox Path and Remote Mailbox path of the mailbox file. 

 Command Line Mode: This mode helps to access and migrate GroupWise mailbox without 

accessing the GroupWise Client.exe. Items of the mailbox are easy to migrate by providing the 

software with complete mailbox path. Syntax for providing complete mailbox path is as given below: 

/pr-“mailbox destination location” 

Migrate Archive Items (In case if you want to migrate Archive Items): Kernel Office365 Migrator for 

GroupWise now features migration of archived items of GroupWise User Mailbox(s). Activate the Show 

Archive checkbox from the "Migrate Archive items" section. Following two options are provided for 

migration of archived items: 
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 Use default Archive path: This option takes the default archive file location of the default user 

profile configured and opened in Novell GroupWise client. 

 Specify Archive path: This option takes the file path specified by you for archived file for user 

mailboxes other than the default one. 

 Note: If you have selected Login Mode(s) or Command Line mode then you should always use 
Specify Archive path option to define archive file location of the user mailbox listed in Login or 
Command Line fields. If Use default Archive path option is selected, then the software will display 

the archived items of default user profile configured in GroupWise for migration.  

 

 Note: When you opt for archive migration, software will list only the archived file items for preview 

and saving and other mailbox items are not displayed.  

 

 

Figure 4.3: Migrating Archived Items 
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4.1.1  Default Mode 

Default mode helps to migrate the user mailbox that is opened in Novell GroupWise Server by default. 

 

 

Figure 4.4: Selecting Default Mode to connect to GroupWise Mailbox 

 

Step 1: Select the “Use Default” option to connect to the GroupWise mailbox in Default mode. This option 

is enabled by default in the software. Activate and select the Archive file options to migrate archived emails 

too. 

 Note: Kernel Office365 Migrator for GroupWise in default mode connects to the currently opened 

GroupWise mailbox in Novell GroupWise Client. 

 

Step 2: Click the Next button to continue. Kernel Office365 Migrator for GroupWise will scan the 

GroupWise mailbox for the existing items in it. The found folders: Mailbox, Sent Items, Calendar, Work in 

Progress, Contacts, Documents, Checklist, Archives, Work in Progress, Cabinet, Trash are displayed in a 

tree-like structure.  
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Step 3: Select any of the tab to preview the selected email in Text or HTML format: 

 

 Figure 4.5: Preview of emails and other items of GroupWise User Mailbox 

 

Select any of the GroupWise mailbox folder to view its content. Emails, calendar, contacts and other items 

will be displayed in the left pane of the window. Right pane of the window displays the respective items of 

the folder selected from the left pane. Bottom pane displays the preview of the item selected from the right 

pane of the window.  

The bottom pane of the window contains two tabs: Text and HTML  

Step 4: Click Export button to continue. 
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Figure 4.6: Export Options 

 

Step 5: Select Item types among given options (Mail, Calendar, Tasks and Contacts). Specify the date 

range either predefined time period or specify time period manually. Provide Office365 login details that 

includes Login Name and Password. By default, items will be saved in HTML format, to save in Text format 

select the checkbox “Save item content in text format”. Click on Export button. 

The software displays progress of the Export process. 
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Figure 4.7: Displaying Progress of Migration Process 

 

After the mailbox items get saved. The path will be displayed on the screen. 
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Figure 4.8: Displaying Path of successfully saved Mailbox items 

 

4.1.2 Login Mode 

Login mode provides three sub-modes where mailboxes can be migrated with Online details, Caching 

Mailbox Path and Remote Mailbox Path of the mailbox file. 

 Online Mode: This mode helps to get connected to the GroupWise mailbox with the help of User ID, 

Password of the user mailbox and IP Address and Port of the computer system where User mailbox 

exists or is saved. 

 Caching Mode: This mode helps to get connected to the Caching mailbox of the GroupWise User 

mailbox with the help of User ID and Password of the Caching User Mailbox. 

 Note: While using this mode, make sure that you or your administrator has enabled the Cache 

mode in Novell GroupWise Server.  

 Remote Mode: This mode helps to get connected to the GroupWise User Mailbox through remote path 

of the location where mailbox copy is saved. You need to provide the path and password of the user 

mailbox (if any). 
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4.1.2.1 Online Mode 

After selecting "Select this option to migrate Single GroupWise Mailbox" radio button. 

Step 1: Select the Online radio button to access the GroupWise mailbox in online mode. This option 

activates the User Id, Password, Address and Port text fields to enter the details of the GroupWise mailbox, 

you want to migrate. 

Step 2: Type the User Id and Password of the mailbox which you want to migrate from Novell GroupWise 

to Office365. Also type the IP address and Port number of the computer where Novell GroupWise server is 

installed. 

 

Figure 4.9: Online Mode 

 

Step 3: Click Next button to proceed. 

Kernel Office365 Migrator for GroupWise will get connected to the provided details of the User Mailbox, 

scan the file to extract items and then software will list them in a tree-like structure. 

Select any of the GroupWise mailbox item to view its contents. Emails, Calendar, Contacts and other items 

will be displayed in the left pane of the window. Right pane of the window displays the respective items of 
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the folder selected from the left pane. Bottom pane displays the preview of the item selected from the right 

pane of the window. The bottom pane of the window contains two tabs: Text and HTML. Select any of the 

tab to preview the selected email in Text or HTML format. 

 

Figure 4.10: Displaying preview of migrated emails of selected folder 

 

Step 4: Click Export button to continue. Software will ask you to select the Save option to save the 

migrated file items. Select Item type and specify the date range. Provide Office365 login details. By default, 

items will be saved in HTML format, to save in Text format select the optional checkbox. 

 

4.1.2.2 Caching Mode 

After selecting "Select this option to migrate Single GroupWise Mailbox" radio button. 

Step 1: Select the "Caching mailbox path" radio button to access the GroupWise mailbox in cache mode. 

This option activates the User Id and Password text field to enter the User Id and Password of the 

GroupWise mailbox, you want to migrate. 
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Step 2: Type the User Id and Password of the mailbox which you want to migrate from Novell GroupWise 

to Office365. Also define the caching mailbox path with the button.  

 

Figure 4.11: Caching Mode 

 

Step 3: Click Next button to proceed. Kernel Office365 Migrator for GroupWise will scan the GroupWise 

mailbox for the existing items in it. The found Mailbox Items, Sent Items, Calendar Items, Work in Progress 

and other folders are displayed in a tree-like structure.  

Select any of the GroupWise mailbox item to view its contents. Emails, Calendar, Contacts and other items 

will be displayed in the left pane of the window. Right pane of the window displays the respective items of 

the folder selected from the left pane. Bottom pane displays the preview of the item selected from the right 

pane of the window.  

The bottom pane of the window contains two tabs: Text and HTML. Select any of the tab preview the 

selected email in Text or HTML format. 

Step 4: Click Export button to continue.  

Select Item type and specify the date range. Provide Office365 login details. By default, items will be saved 

in HTML format, to save in Text format select the optional checkbox. 
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4.1.2.3 Remote Mode 

After selecting "Select this option to migrate Single GroupWise Mailbox" radio button. 

Step 1: Select the "Remote mailbox path" radio button to access the GroupWise mailbox in remote mode. 

This option activates Password text field to enter the Password of the GroupWise mailbox. 

 Note: Password is required for only those mailboxes which are password-protected, otherwise 

there is no need to provide password for authentication.  

 

Step 2: Type the password of the mailbox which you want to migrate using Kernel Office365 Migrator for 

GroupWise. Also define the Remote mailbox path through the  button. 

 

Figure 4.12: Remote Mode 

 

Step 3: Click Next button to proceed. Kernel Office365 Migrator for GroupWise will scan the GroupWise 

mailbox for the existing items in it. The found mailbox, sent items, calendar, Work in Progress and other 

folders are displayed in a tree-like structure.  
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Step 4: Select any of the GroupWise mailbox item to view its contents. Emails, Calendar, Contacts and 

other items will be displayed in the left pane of the window. Right pane of the window displays the 

respective items of the folder selected from the left pane. Bottom pane displays the preview of the item 

selected from the right pane of the window. The bottom pane of the window contains two tabs: Text and 

HTML. Select any of the tab to view preview of the selected email in Text or HTML format. 

Step 5: Click Export button to continue. Select Item type and specify the date range. Provide Office365 

login details. By default, items will be saved in HTML format, to save in Text format select the optional 

checkbox. 

 

4.1.3 Command Line Mode 

Command Line mode of Kernel Office365 Migrator for GroupWise helps you to access the GroupWise 

mailbox without opening or accessing the GroupWise.exe and user mailbox account. If you know the path 

where GroupWise mailbox is saved, then type the path in Command Line mode and access that account 

for migration. 

Step 1: Select Command Line (for advance migration) radio button to perform the migration with 

Command Line Mode. 

 

Figure 4.13: Command Line Mode 
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Software will ask you to define the User Id, Password and Path of the GroupWise user mailbox to carry out 

the migration process.  

Step 2: Type the User ID, Password and the User GroupWise Mailbox path. Novell GroupWise Client can 

be accessed remotely with the switch and the complete path of the GroupWise user mailbox which is 

required to be migrated. 

Step 3: Click the Export button to continue. 

Kernel Office365 Migrator for GroupWise will scan the GroupWise mailbox for the existing items in it. The 

found Mailbox, Sent Items, Calendar, Work in Progress and other folders are displayed in a tree-like 

structure.  

Select any of the GroupWise mailbox folder to view its content. Emails, Calendar, Contacts and other items 

will be displayed in the left pane of the window. Right pane of the window contains the respective items of 

the folder selected from the left pane. Bottom pane displays the preview of the item selected from the right 

pane of the window.  

The bottom pane of the window contains two tabs: Text and HTML. Select any of the tab to view preview of 

the selected email in Text or HTML format. 

Step 4: Click Export button to continue. Select Item type and specify the date range. Provide Office365 

login details. By default, items will be saved in HTML format, to save in Text format select the optional 

checkbox. 

 

4.2 Migrate Multiple GroupWise Mailboxes 

Migrate Batch of GroupWise Mailbox, also defined as Multiple Files migration mode helps to migrate batch 

file of GroupWise mailboxes which stores details of 100s and 1000s GroupWise user mailboxes. Unlimited 

GroupWise mailboxes are easy to migrate with this option. 

4.2.1  Migrate Batch of GroupWise Mailboxes with .NUCON File 

Multiple GroupWise mailboxes migration is performed with the help of previously created .NUCON batch 

file. Kernel Office365 Migrator for GroupWise lets you create a batch file with Kernel Office365 Migrator for 

GroupWise Batch File Creator software. The created batch file has to be listed in the Multiple File migration 

section for the migration process. 

 Note: Refer Product Guide for Kernel Office365 Migrator for GroupWise Batch File Creator 

software to know the steps to create a batch file for multiple GroupWise mailbox migration. 

 

Execute the “migrate batch file option” and then let software do its work. There is no need to provide any 

authentication of password or login details as these details are already defined in the .NUCON file.  
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Step1: Launch Kernel Office365 Migrator for GroupWise software. Select the radio button: “Select this 

option to migrate batch of GroupWise Mailboxes”. 

  

Figure 4.14: Selecting Batch GroupWise Mailboxes Migration Option 

 

Step 2: Click Next button. Software will open the window to select and list the *.NUCON batch file created 

with Kernel Office365 Migrator for GroupWise Batch File Creator software. 
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Figure 4.15: Selecting and Listing .NUCON Batch File 

 

Step 3: Select the .NUCON file and click the Open button. The batch file items will get listed in the 

software: 
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Figure 4.16: Displaying List of multiple .NUCON Batch File 

 

 Note: You can list only 1 batch file at a time. To list and migrate another batch file, click the Select 

File button.  

 

One batch file can have 100s and 1000s of user mailbox details which can be saved to Office365.  

Step 4: Click the Export button. Software will start the process of saving. Before starting the process, 

software will display message for address book migration: Do you want to export address book also? 

Click Yes if you want to perform the migration or No if you do not want to perform the migration. 
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Figure 4.17: Displaying the progress of migration process 

 

 Note: During the Saving Process, you can Hide/Show the running saving information to speed up 
the save process. Click the Hide Progress button to hide it and click Show Progress button to 

again resume the progress.  

 

After successful saving, software will display the following message: "Saving Complete". Novell 

GroupWise mailbox emails and other items are now successfully saved and can be viewed in Office365. 

 

4.2.2 Create Excel Database for Batch Migration 

Take advantage of new beneficial feature added in Kernel Office365 Migrator for GroupWise software. 

Create an Excel Sheet (.xls) and save details of as many GroupWise mailboxes and then import it in Kernel 

Office365 Migrator for GroupWise Batch File Creator software. After this, save the listed items as .NUCON 

file for batch migration of GroupWise Mailboxes in Kernel Office365 Migrator for GroupWise software.  

 Note: Refer to the Product Guide for Kernel Office365 Migrator for GroupWise Batch File Creator 

software for more details. 
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5. Download, Purchase and Register 

5.1 Free Trial Download 

The trial version of Kernel Office365 Migrator for GroupWise is available as an evaluation version for free 
of cost, using which a user can evaluate and analyze the features, functionalities and capabilities of the 
software before making actual purchase. Free trial version of Kernel Office365 Migrator for GroupWise is 
completely functional and works almost similar to that of the full version but has a limitation that allows 
saving only 10 emails per folder of the GroupWise mailbox. 

To overcome the limitation of free trial version, purchase the full and licensed version of the software. Free 
version of Kernel Office365 Migrator for GroupWise can be downloaded from our safe and secure website: 

http://www.nucleustechnologies.com/download-groupwise-to-office365.html  

 

5.2 Purchase & Register 

Purchase the Full version of Kernel Office365 Migrator for GroupWise in order to save entire email 
messages of Novell GroupWise mailboxes. Purchase the Full version of Kernel Office365 Migrator for 
GroupWise through our encrypted and secure Website: 

http://www.nucleustechnologies.com/buy-groupwise-to-office365.html  

 

Payment and Delivery 

Purchase Kernel Office365 Migrator for GroupWise software from our authorized resellers, which provide 
number of payment options for your ease - PayPal, FAX, Credit Card, E-cheque, Pay Order, etc. 

After making the purchase transaction with our resellers, an email is sent consisting of activation details 
and download link for the Full version of Kernel Office365 Migrator for GroupWise comprising of the 
activation code. This email is sent to the email address, which you have used while processing the 
purchase transaction with our resellers. We suggest you not to use false email address while making the 
purchase transaction. 

For any other details related to purchase process, software activation process, email us at: 

sales@nucleustechnologies.com 

 

5.3 Support 

Lepide Software Pvt. Ltd. provides round-the-clock technical support for its product range to solve technical 
and software queries. Kernel Office365 Migrator for GroupWise software comes with an embedded user 
help manual that can be accessed by clicking Help in the software main window. You can also press the 
F1 key on the keyboard of your computer to access the embedded user help manual of Kernel Office365 

Migrator for GroupWise. 

We also have Live Support wherein you can chat with our software experts at:  

http://www.nucleustechnologies.com/download-groupwise-to-office365.html
http://www.nucleustechnologies.com/buy-groupwise-to-office365.html
mailto:sales@nucleustechnologies.com
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http://www.nucleustechnologies.com/supportdesk/ 

 

Telephone Support: 

+91-9818725861 

1-866-348-7872 (Toll Free for USA/CANADA) 

Email Support: 

sales@nucleustechnologies.com for Sales 

support@nucleustechnologies.com for Support 

contact@nucleustechnologies.com for General Queries 

  

http://www.nucleustechnologies.com/supportdesk/
mailto:sales@nucleustechnologies.com
mailto:support@nucleustechnologies.com
mailto:contact@nucleustechnologies.com
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6. Troubleshooting 

6.1 Common Issues 

1. What is the difference between Single GroupWise mailbox and Batch file migration? 

Ans: Single Mailbox migration option migrates single GroupWise mailbox at a time and defines saving 
option after scanning all Novell GroupWise mailbox items using Kernel Office365 Migrator for GroupWise. 

On the other hand, Multiple Mailbox migration/ Batch of GroupWise Mailboxes migration option migrates 
unlimited GroupWise mailboxes saved in one batch file. This option allows defining saving details at the 
time of batch file creation. The feature allows creating .XLS file for saving mailbox details which is then 
saved as .NUCON batch file migration and thus saves time. 

2. What are the limitations of Free Evaluation version? 

Ans: The free evaluation version of Kernel Office365 Migrator for GroupWise is fully functional in its 
migration capabilities. The free trial version migrates Novell GroupWise mailboxes, displays preview of 
migrated emails with data but allows saving only first 10 emails per folder existing in the User Mailbox to 
Office365. 

 

6.2 Frequently Asked Questions 

1. What are the supported Novell GroupWise Server versions for Kernel Office365 Migrator for 
GroupWise? 

Ans: Kernel Office365 Migrator for GroupWise supports Novell GroupWise Server 6, 6.5, 7, 8 and 12 

versions. 

2. What are the supported MS Excel versions? 

Ans: Kernel Office365 Migrator for GroupWise supports MS Excel 97, 98, 2000, 2002, 2003, 2007 and 

2010 versions. 

3. What are the supported Operating system platforms for Kernel Office365 Migrator for 
GroupWise? 

Ans: The software supports Windows Server 2000, Windows Server 2003, Windows XP, Windows Vista, 

Windows Server 2008, Windows Server 2008 R2, Windows 7, and Windows 8 operating systems 
platforms. 

4. What are the various migration options offered by the Kernel Office365 Migrator for GroupWise 
software? 

Ans: Kernel Office365 Migrator for GroupWise offers two migration options – Migrate Single GroupWise 

Mailbox and Migrate batch of GroupWise Mailboxes. 
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5. What are the various modes offered by the software to connect to GroupWise mailboxes? 

Ans: The software offers various modes to connect to Novell GroupWise mailboxes such as Default Mode, 

Login Mode – Online Mode, Caching Mode, Remote Mode; and Command Line Mode. 

6. Does software supports migrating archived items? 

Ans: Yes, the software fully supports migrating archived items. 

7. What are the two options for migrating batch of GroupWise Mailboxes? 

Ans: The two options for migrating batch of GroupWise mailboxes are: Migrate with .NUCON batch file and 
Migrate with .XLS Batch file. 

8. From where one can purchase the Kernel Office365 Migrator for GroupWise? 

Ans: Purchase the full licensed version of the software from the secure website: 

http://www.nucleustechnologies.com/buy-groupwise-to-office365.html  

9. Give the link for downloading the free trial version of the software? 

Ans: Download the free trial version of the software from the secure website:  

http://www.nucleustechnologies.com/download-groupwise-to-office365.html  

  

http://www.nucleustechnologies.com/buy-groupwise-to-office365.html
http://www.nucleustechnologies.com/download-groupwise-to-office365.html
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1. About Kernel Office365 Migrator for GroupWise 

Batch File Creator 

1.1 Brief about this User Manual 

Welcome to the user manual of Kernel Office365 Migrator for GroupWise Batch File Creator, an apt 
solution to create batch file to store records of Multiple GroupWise Mailboxes in one file and migrate 100s 
and 1000s of User Mailboxes at once. This user manual guides users on successfully operating the 
software. It is recommended that novice as well as experienced users should carefully go through this user 
manual before using the software. A user who is well aware of the software can even use table of contents 
for finding the particular portion of manual. The table of contents enlists all the sections described in this 
user manual from where one can navigate through its different sections. The user manual consists of step-
by-step guidelines for using Kernel Office365 Migrator for GroupWise Batch File Creator software. The 
user manual is intended to guide those users who are using this software for the first time. The user 
manual consists of the following sections for guiding the users: 

 Introduction 

 User Interface Description 

 Usage Guidelines  

 

1.2 Introduction to Kernel Office365 Migrator for GroupWise Batch 

File Creator Software 

Kernel Office365 Migrator for GroupWise Batch File Creator is an advanced, professional and result-
oriented software that allows users for creating batch files in order to store records of unlimited Novell 
GroupWise User Mailboxes in a single file that helps in migrating multiple user mailboxes from Novell 
GroupWise Server environment to Office365 environment with complete accuracy. The software offers 
accurate creation of batch file that serves for performing migration from Novell GroupWise to Office365. 
The software is mostly used by organizations, companies, administrators, technicians or individuals who 
want to migrate from Novell GroupWise Server to Office365. 

Kernel Office365 Migrator for GroupWise Batch File Creator is a batch file creation software that creates 
batch file(s) for migrating multiple user mailboxes from Novell GroupWise to Office365. The software offers 
options for migrating Unlimited GroupWise mailbox migration using a .NUCON file as well as with the help 
of MS Excel .XLS file. 

Unlimited GroupWise mailboxes migration option allows creating a .NUCON batch file or an .XLS Excel 
sheet of GroupWise mailboxes consisting of complete details of user mailboxes to be migrated and thus 
saves administrators time of migrating user mailboxes one-by-one. 

The software offers easy-to-use, highly interactive, self-descriptive, user-friendly graphical user interface 
such that non-technical users can easily operate it without any technical training. 
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Kernel Office365 Migrator for GroupWise supports every version of Novell GroupWise and MS Excel for 
creating a batch file. 

 

1.3 Salient Features 

Some of the key features of Kernel Office365 Migrator for GroupWise software are as follows: 

 Allows creating a .NUCON batch file or an .XLS Excel sheet consisting of records of GroupWise 
User Mailboxes with complete details to be migrated. 

 The software gets automatically installed as the Kernel Office365 Migrator for GroupWise is 
installed. 

 Uses simple Excel worksheet to enlist mailboxes for batch migration. 

 Supports every version of Novell GroupWise Server and MS Excel for creating the batch file for 
performing the migration process. 

 Offers easy-to-use, simple, self-descriptive, attractive, user-friendly graphical user interface. No 
technical skills required for operating the software. 

 

 

 

  



© L e p i d e  S o f t w a r e  P r i v a t e  L i m i t e d               

2. Understanding the User Interface 

2.1 Welcome Screen of the Software 

Kernel Office365 Migrator for GroupWise Batch File Creator software offers user-friendly, attractive 
graphical user interface. When the software is launched, following Welcome Screen appears: 

 

 

Figure 2.2: Welcome Screen of Kernel Office365 Migrator for GroupWise Batch File Creator 

 

2.2 Menu Bar 

      The Menu bar of Kernel Office365 Migrator for GroupWise batch File Creator software comprises of four 
menu items that are further divided into several sub-menu items. The four menu items are: 

 File Menu 

 Edit Menu 

 View Menu 
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 Help Menu 

File Menu 

The File menu of Kernel Office365 Migrator for GroupWise batch File Creator appears, as shown in the 

following figure: 

 

Figure 2.2: File Menu 

The following table enlists the options available in the File menu: 

 

 

 

 

 

 

 

 

Edit Menu 

The Edit menu of Kernel Office365 Migrator for GroupWise Batch File Creator appears, as shown in the 

following figure: 

 

Figure 2.3: Edit Menu 

The following table enlists the option available in the Edit menu: 

 

Option Description 

New File Select this option to remove all existing records listed in the Kernel 
Office365 Migrator for GroupWise Batch File Creator software and 
create new record for a new batch file 

Add Record Select this option to add new record of the user mailbox in a batch 
file 

Open Select this option to open an existing .NUCON batch file 

Save Select this option to save the .NUCON batch file 

Save As Select this option to select the location on your hard drive to save 
the .NUCON Kernel batch file 

Exit Select this option to exit from the software 

Option Description 

Remove Select this option to remove the selected record from the list 
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View Menu 

The View menu of Kernel Office365 Migrator for GroupWise Batch File Creator appears, as shown in the 

following figure: 

 

Figure 2.4: View Menu 

The following table enlists the option available in the View menu: 

 

 

 

 

Help Menu 

The Help menu of Kernel Office365 Migrator for GroupWise Batch File Creator software appears, as 

shown in the following figure: 

 

Figure 2.5: Help Menu 

The following table enlists the options available in the Help menu: 

Option Description 

Help Opens the user’s help manual of Kernel Office365 Migrator for GroupWise 
Batch File Creator software 

Software home page… Opens homepage of the software on the Website 

About Kernel Office365 
Migrator for GroupWise 

Batch File Creator 

Displays the version information and support details of the software 

 

  

Option Description 

Toolbars Select this option to view or hide toolbar of Kernel Office365 
Migrator for GroupWise Batch File Creator Software 

Status Bar Select this option to view or hide status bar of Kernel Office365 
Migrator for GroupWise Batch File Creator Software 
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2.3 Tool Bar 

The Tool bar is displayed just below the Menu bar section of the software interface and consists of buttons 
that offers a convenient method for performing varied functions. 

 

Figure 2.6: Tool Bar 

Following table enlists the buttons available on the Tool bar of Kernel Office365 Migrator for GroupWise:  

Button Button Name Description 

 

New Click this button to remove all existing records listed in the Kernel Office365 
Migrator for GroupWise Batch File Creator software and create new record 
for a new Kernel batch file 

 

Open Click this button to open an existing .NUCON file 

 

Save Click this button to save the .NUCON batch file 

 

Save As Click this button to define the location on your hard drive to save the 
.NUCON batch file 

 

Add Record Click this button to add the records/details of the GroupWise user mailbox 
and saving options 

 

Remove Click this button to remove the selected record from the list 

 

Help Click this button to view User’s Help Manual of Kernel Office365 Migrator for 
GroupWise Batch File Creator software 

 

Import Excel Click this button to import Excel worksheet with added information about the 
batch of GroupWise mailboxes to be migrated. 

  



© L e p i d e  S o f t w a r e  P r i v a t e  L i m i t e d               

3. Getting Started with the Software 

3.1 What is Batch File? 

Batch file is a .NUCON file created to list and record details of unlimited GroupWise user mailboxes for 

migrating to Office365 mailbox. Batch file helps to migrate unlimited GroupWise User Mailboxes at once.  

Batch file resolves overhead of migrating Single GroupWise User Mailbox one by one. Batch file is created 

with the help of Kernel Office365 Migrator for GroupWise Batch File Creator software. All the details of the 

GroupWise user mailboxes and their saving modes are provided in Kernel Office365 Migrator for 

GroupWise Batch File Creator software to create a .NUCON batch file.  

Creation of batch file saves the valuable time of administrators/technicians. After saving, a .NUCON batch 

file looks like as: 

 

Figure 3.1: A .NUCON Batch File 

 

3.2 How to create .NUCON Batch File? 

Batch file is a medium through which you can easily list and migrate unlimited GroupWise user mailboxes 

at once. Create batch file and store records of unlimited GroupWise user mailbox accounts. Creation of 

batch file eases the task of defining saving location and saving mode for the migrated mailboxes in 

Office365.  

Step 1: Launch Kernel Office365 Migrator for GroupWise Batch File Creator software. The Main 

window of the software appears. 
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Figure 3.2: Main Window of Kernel Office365 Migrator for GroupWise Batch File Creator 

 

Step 2: Select Add Record option from the File menu or click the Add Record button from the tool bar. 

The GroupWise Information window appears as: 
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Figure 3.3: GroupWise Information Window 

 

GroupWise Login Details Section Description: 

User Id Type the User ID of the user mailbox to be migrated 

Password Type the password of the user mailbox 

Online Select this radio button to connect to the 

GroupWise user mailbox in online mode. 

Type the IP Address and Port Number to access 

the GroupWise mailbox in Online Mode. 

Caching Mailbox Path Select Caching mailbox path from the  button 

Remote Mailbox Path Select Remote mailbox path from the  button 

Command Line (for 

advance migration) 

Define Command Line to access the 

GroupWise.exe 
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 Note: Select any of the Mode (Online, Caching, Remote, or Command Line) to get access to the 

GroupWise user mailbox.  

 

Advance Options Section Description: 

User Name Type the User Name of the computer system where remote mailbox is stored 

Password Type the password of the computer where the remote mailbox is stored 

Computer Name/IP Type the computer name and IP Address of the computer system where the 

remote mailbox is stored 

 

Archive Details Section Description: 

Migrate Archive 

Items 

Select the checkbox to define details of archive folder for a user mailbox for 

migration. This section helps to migrate archived items for a mailbox. 

Use default Archive 

path 

This option takes the default archive file location of the default user profile 

configured and opened in Novell GroupWise client. 

Specify Path This option takes the file path specified by you for archived file for user 

mailboxes other than the default one. 

 

 Note: If you have selected Login Mode(s) or Command Line mode then you should always 
activate and use Specify Archive path option to define archive file location of the user mailbox 
listed in Login or Command Line fields. If Use default Archive path option is selected, then the 

software will display the archived items of default user profile configured in GroupWise for 

migration. 

 

 Note: When you opt for archive migration, software will list only the archived file items for preview 

and saving. Other mailbox items are not displayed when you select to migrate archived items. 

 

Step 3: Click Next button to proceed further. The Office365 Information window gets displayed. Specify the 

Login Name and Password of the Office365 mailbox. 
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Figure 3.4: Office365 Information Window 

 

Step 4: Click Finish button to continue. All the created records of the GroupWise User Mailboxes get listed 

in the Kernel software. 
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Figure 3.5: Displaying added records of GroupWise User Mailboxes 

 

 Note: You can edit details of the selected GroupWise User Mailbox from left pane of the window, 

that is, the Record Details section in the Kernel software.  

 

Step 5: Click the Save button from the tool bar to save the batch file or click the Save As button to select 

and save disk saving location of the file on your computer system. 

 

Figure 3.6: Saving .NUCON File 

Kernel Office365 Migrator for GroupWise Batch File Creator software by default creates *.nucon file which 

is the batch file for multiple mailbox migration. 

 

3.3 How to create Excel Database? 

Complete information about the Novell GroupWise user mailboxes is now easily saved to an Excel 

worksheet according to the provided file format. As an administrator you save a lot of time which gets 

utilized in creating .NUCON batch file and editing it. Now save details in .XLS file and export it to Kernel 

Office365 Migrator for GroupWise Batch File Creator software to get it saved to .NUCON batch file. 
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Figure 3.7: Creating an .XLS File 

 

The Excel sheet (.XLS) to be imported should have following columns: 

Field 1 Mode 

Field 2 User ID 

Field 3 Password 

Field 4 Address 

Field 5 Port 

Field 6 Caching Mailbox Path 

Field 7 Remote Mailbox Path 

Field 8 Command Line 

Field 9 User Name 

Field 10 User Password 

Field 11 Computer Name/IP 
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Pre-requisites to fill the columns: 

The different fields are to be filled according to one of the login types selected. The four login types are: 

1. Online  

2. Caching Mailbox Path  

3. Remote Mailbox Path  

4. Command Line (for advanced migration)  

The Field 1(Mode) of the Excel sheet can take any one of the above-mentioned values only. The rules to 

fill different fields according to login type are as follows:  

Login Mode (Online) 

Following are the mandatory fields to be filled in while using this mode: 

1. User ID: Type the user name of the mailbox.  

2. Password: Type the password of user mailbox.  

3. Address: Type the IP address of the Novell GroupWise Server  

4. Port: Type the Port Number of the Novell GroupWise Server. 

5. Archive Details: Always type "NO" in this field if you want to migrate the mailbox items only. 

Login Mode (Caching Mailbox Path): 

Following are the mandatory fields to be filled in while using this mode: 

1. User ID: Type the user name of the mailbox.  

2. Password: Type the password of user mailbox (if any).  

3. Caching Mailbox Path: Browse and list the path for Caching Mailbox of Novell GroupWise account to 

be migrated.  

4. Archive Details: Always type "NO" in this field if you want to migrate the mailbox items only. 

5. Advance Options: Provide details to these fields if you are accessing the Caching mailbox from a 

network computer. This section will comprise of the login details of the computer in network. There are 

three fields in advanced options:  

Field 12 Domain 

Field 13 Login Name 

Field 14 Office365 Password 

Field 15 Save Archive 

Field 16 Archive Path 
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 User Name of the network computer where mailbox is saved 

 Password of the network computer where mailbox is saved 

 Computer Name/IP of the network computer where mailbox is saved  

Advanced options fields are not compulsory, but recommended. If not filled, it will be shown as a warning.  

 

Login Mode (Remote Mailbox Path): 

Following are the mandatory fields to be filled in while using this mode: 

1. Password: Type the password of user mailbox (if any).  

2. Remote Mailbox Path: Browse and list the path of remote mailbox path of Novell GroupWise account to 

be migrated. 

3. Archive Details: Always type "NO" in this field if you want to migrate the mailbox items only. 

4. Advance Options: Provide details to these fields if you are accessing the Remote mailbox from a 

network computer. This section will comprise of the login details of the computer in network. There are 

three fields in advanced options:  

 User Name of the network computer where mailbox is saved  

 Password of the network computer where mailbox is saved 

 Computer Name/IP of the network computer where mailbox is saved 

 

Login Type (Command Line): 

Following are the mandatory fields to be filled in while using this mode: 

1. User ID: Type the user name of the mailbox.  

2. Password: Type the password of user mailbox.  

3. Command Line: This field is compulsory. If this field is left blank, error will be shown. 

4. Archive Details: Always type "NO" in this field if you want to migrate the mailbox items only. 

 

3.3.1  Migrating Archived Items 

If the archived items for mailbox(s) are the need of hour for migration and you need to work with the Excel 

database, then perform the following steps for this process: 

Step 1: Open the Excel database. Let's suppose that we are using the Remote Mailbox mode and need to 

migrate the archived items for mailbox(s). 

Step 2: Fill the columns with required details and type YES or Path of the archive folder of the user 

mailbox. 
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 Note: Fill only one field amongst Save Archive and Archive Path. If both the fields are filled, 

software will display errors.  

 

 

Figure 3.8: An .XLS File with all records 

 

 Note: When you opt for archive migration, software will list only the archived file items for preview 

and saving. Other mailbox items are not displayed when you select to migrate archived items. 

 

Step 3: Import the Excel database to Kernel Office365 Migrator for GroupWise Batch File Creator which 

will then display Compilation Output window with errors, warnings, and total number of scanned records 

from the Excel database. 
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Figure 3.9: Imported .XLS File in the software 

 

Step 4: Click Save As to save the records in .NUCON batch file at the appropriate location.  

Step 5: Launch Kernel Office365 Migrator for GroupWise and select the batch file migration option to list 

and perform the migration with .NUCON file. 

 

3.4 How to Import Excel Database? 

Export the Excel database to Kernel Office365 Migrator for GroupWise Batch File Creator and save it as 

.NUCON file.  

Step 1: Launch Kernel Office365 Migrator for GroupWise Batch File Creator software. Main window of 

the software appears. 

Step 2: Click Import Excel button from the Toolbar. Software will display the Open window to select the 

Lepide.xls from the saved location. Browse and list the Excel sheet. 
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Figure 3.10: Selecting .XLS File to be imported in the software 

 

As you list the file in software, it displays a window with compilation output for the total records scanned 

from the Excel sheet. Modify as per the compilation output provided by the software. If there are no errors 

then click OK to proceed. 

 

Figure 3.11: Compilation Output Window 

The saved mailbox details will get listed in the software. 

Step 3: Click the Save As button from the toolbar to save the listed items as .NUCON batch file at 

appropriate location. 

Now launch Kernel Office365 Migrator for GroupWise software and select the option to migrate batch of 

GroupWise Mailboxes and list the .NUCON batch file for migration. 
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3.5 Where is .NUCON Batch File Used? 

Batch file is used in the Kernel Office365 Migrator for GroupWise software application to perform the 

mailbox migration process.  

Launch Kernel Office365 Migrator for GroupWise software. The main window appears. 

 

 

Figure 3.12: Selecting Batch GroupWise Mailboxes Migration Option 

 

Step 1: Select the "Select this option to migrate batch of GroupWise mailboxes" radio button. The 

“Open” window gets displayed. 
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Figure 3.13: Selecting .NUCON Batch File for batch GroupWise Mailboxes Migration 

 

Step 2: Select the batch file of .NUCON file extension and click the "Open" button. The window displays 

the saved records in the Batch file.  

Step 3: Click the "Export" button to perform the migration of unlimited GroupWise mailboxes to Office365. 

After this, Kernel Office365 Migrator for GroupWise software starts the saving process of the GroupWise 

user mailboxes and save the migrated mailbox items at the defined save location.  

 Note: To view further steps, refer to How to migrate Batch of GroupWise Mailboxes section in Kernel 

Office365 Migrator for GroupWise – Product Guide. 
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7. Legal Notices 

This section comprises the legal specification about Kernel Office365 Migrator for GroupWise and the 
company Lepide Software Private Limited. 

 

7.1 Copyright Notice 

Lepide Software Private Limited, Kernel Office365 Migrator for GroupWise, accompanied user manual, 
and documentation are copyright of Lepide Software, with all rights reserved. Under the copyright laws, 
this user manual cannot be reproduced in any form without the prior written permission of Lepide 
Software. No Patent Liability is assumed, however, with respect to the use of the information contained 
herein. 

© LEPIDE SOFTWARE PVT LTD. All rights reserved. 

 

7.2 Trademarks 

Kernel Office365 Migrator for GroupWise ® is a copyright work of Lepide Software Private Limited. 

Windows 8®, Windows 7®, Windows Vista®, Windows XP®, Windows 2003®, Windows 2000®, Windows 
98®, and Windows 95® are registered trademarks of Microsoft Corporation. All other brand and product 
names are trademarks or registered trademarks of their respective companies. 

 

7.3 Disclaimer 

The information contained in this user manual, including but not limited to any product specifications is 
subject to change without notice. Lepide Software Private Limited provides no warranty with regard to this 
user manual or any other information contained herein and hereby expressly disclaims any implied 
warranties of merchantability or fitness for any particular purpose with regard to any of the foregoing. 
Lepide Software Private Limited assumes no liability for any damages incurred directly or indirectly from 
any technical or typographical errors or omissions contained herein or for discrepancies between the 
product and the user manual. 

In no event shall Lepide Software Private Limited be liable for any incidental, consequential special or 
exemplary damages, whether based on tort, contract or otherwise, arising out of or in connection with this 
user manual or any other information contained herein or the use thereof. 
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7.4 License Agreement 

Kernel Office365 Migrator for GroupWise© by Lepide Software Private Limited. 

 

Your Agreement to this License 

You should carefully read the following terms and conditions before using, installing, or distributing this 
software, unless you have a different license agreement signed by Lepide Software Private Limited. The 
terms and conditions of this License describe the permitted use and users of each Licensed Copy of 
Kernel Office365 Migrator for GroupWise. For purposes of this License, if you have a valid license, you 
have the right to use a single Licensed Copy of Lepide. 

 

Scope of License 

Each Licensed Copy of Kernel Office365 Migrator for GroupWise may either be used by a single person 
or used non-simultaneously by multiple people who use the software personally installed on a single 
workstation. All rights of any kind in the Lepide, which are not expressly granted in this License, are 
entirely and exclusively reserved to and by Lepide Software. You may not rent, lease, modify, translate, 
reverse engineer, decompile, disassemble, or create derivative works based on, Lepide, nor permit 
anyone else to do so. You may not make access to Lepide available to others in connection with a service 
bureau, application service provider, or similar business, nor permit anyone else to do so. 

 

Warranty Disclaimers and Liability Limitations 

Kernel Office365 Migrator for GroupWise, and any and all accompanying software, files, data and 
materials, are distributed and provided as is and with no warranties of any kind, whether expressed or 
implied. In particular, there is no warranty for the quality of data recovered. You acknowledge that good 
data processing procedure dictates that any program, including Kernel Office365 Migrator for GroupWise, 
must be thoroughly tested with non-critical data before there is any reliance on it, and you hereby assume 
the entire risk of all use of the copies of Kernel Office365 Migrator for GroupWise covered by this License. 
This disclaimer of warranty constitutes an essential part of this License. In addition, in no event does 
Lepide Software authorize you or anyone else to use Kernel Office365 Migrator for GroupWise in 
applications or systems where Kernel Office365 Migrator for GroupWise failure to perform can reasonably 
be expected to result in a significant physical injury, or in loss of life. Any such use is entirely at your own 
risk, and you agree to hold Lepide Software harmless from any and all claims or losses relating to such 
unauthorized use. 

 

General 
 
This License is the complete statement of the agreement between the parties on the subject matter, and 
merges and supersedes all other or prior understandings, purchase orders, agreements, and 
arrangements. This License shall be governed by the laws of the State of Delhi. Exclusive jurisdiction and 
venue for all matters relating to this License shall be in courts and for a located in the State of Delhi, and 
you consent to such jurisdiction and venue. There are no third-party beneficiaries of any promises, 
obligations, or representations made by Lepide Software herein. Any waiver by Lepide Software of any 
violation of this License by you shall not constitute, nor contribute to, a waiver by Lepide Software of any 
other or future violation of the same provision, or any other provision, of this License. 

 


